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USER'S GUIDE TO STAT, THE SHADWELL TEST ANALYSIS TOOL 

(VERSION   1.0) 

PART I PURPOSE AND CAPABILITIES 

This document is presented in two parts. Part I discusses the purpose of the SHADWELL Test 
Analysis Tool (STAT) and provides installation instructions and an overview of its capabilities. It 
is hoped that most readers will find this sufficient to begin using the program. Those who want 
more in-depth explanations, Part II discusses all STAT menu commands and dialog boxes in 
detail. 

1.0 INTRODUCTION 

1.1 The SHADWELL Data Collection System 

The ex-USS SHADWELL is the Naval Research Laboratory's (NRL) full-scale damage control 
test platform. Tests conducted in the heavily instrumented experimental areas permit NRL to study 
the development of fires and the effects of new fire fighting equipment and techniques. The test 
facility and its capabilities have been documented in previous reports [1] and will not be described 
in detail here. However, some discussion of the shipboard data collection system is necessary. 

SHADWELL's data acquisition system consists of two, 200-channel dataloggers controlled by 
custom real-time software running on a Unix-based MassComp computer. The software permits 
each data channel to be individually configured, including adjustment of the span and gain of the 
analog to digital (A/D) converters and specification of coefficients for conversion of the raw 
voltage inputs to engineering units. As data are acquired, the MassComp stores them to two binary 
disk files (one for each of the dataloggers) and provides real time display of selected channels on 
multiple monitors in the SHADWELL control room. At the conclusion of each test, the two data 
files are compressed and saved to tape in UNIX tar archives. Other files, which describe the 
datalogger configuration settings used during the test, are also archived on the tape. 

Another custom program, TRANSLATE, provides capabilities for off-line processing of the 
archival data. Using the configuration settings files, this software extracts data for specified 
channels from the binary files and converts the data to ASCII (text) files. These ASCII files are 
arranged in a columnar format, with one column for the clock time at which data readings were 
taken and an additional column for each selected data channel. These ASCII files may then be 
imported into standard spreadsheet or graphics programs for analysis or display. 

1.2 The SHADWELL Test Analysis Tool 

An analysis of the ASCII data is often very labor-intensive, requiring 
a. selection of data columns representing specific instruments in particular 

compartments; 
b. removal of data from open or shorted sensors; 
c. filtering of noise spikes; 
d. correction of offset errors in each channel; 
e. calculation of sensor averages and standard deviations (if there are multiple 

channels of similar data); and 
f. data smoothing. 

With the exception of the first step, the analysis has historically been a manual operation. STAT 
was written to aid in the analysis of ASCII data by automating many of the above steps. It is in the 
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form of a Microsoft Excel™ add-in module and provides functions for: (a) defining the test 
configurations; (b) selecting data which meets specified criteria for sensor type and location; (c) 
filtering, normalizing and smoothing data and (d) calculation of sample means and standard 
deviations. STAT was written with the assumption that input files would be in the standard format 
generated by the TRANSLATE binary-to-ASCII file translation utility. 

1.3 Requirements 

STAT requires a Macintosh or IBM-compatible computer with Microsoft Excel (version 5.0 or 
later) installed1. In addition, the Add-In Manager add-in must also be installed. The minimal 
requirements for Excel 5.0, as given by the Excel User's Guide [2] are: 

Excel for Macintosh 
a. MacOS-compatible computer; 
b. 800K-compatible floppy disk drive; 
c. hard disk drive; 
d. at least 4 MB of RAM; and 
e. MacOS 7.0 or later. 

Excel for Windows 
a. IBM-compatible computer with 80286 or higher processor, 
b. 3.5" or 5.25" floppy disk drive; 
c. hard disk drive; 
d. graphics display compatible with Microsoft Windows 3.1 or later (i.e., EGA, VGA 

or better); 
e. at least 4 MB of RAM; and 
f. MS-DOS 3.1 or later and Microsoft Windows 3.1 or later. 

More recent versions of Excel are likely to require faster computers, more memory and newer 
versions of the appropriate operating system. For processing large data sets, a fast PowerPC 
(Macintosh) or Pentium (Windows) processor and a minimum of 32 MB of RAM is strongly 
suggested. 

1.4 Installation 

Install Excel, if necessary, by following the directions included on the installation disks or CD- 
ROM. To install STAT, copy both the STAT2 and Add-In Manager3 add-ins (STAT.XLA and 
AIM.XLA4, respectively) to the Macro Library (Macintosh) or Library (Windows) folder inside 

1 STAT is written in Excel Visual Basic for Applications (VBA) and was developed and tested on Excel version 5 for 
Macintosh. VBA is a cross-platform environment so, in principal, STAT should work equally well on Macintosh or 
Windows and with any version of Excel which supports VBA. In practice, due to inconsistencies in the way that 
different versions of Excel handle VBA scripts, combined with the many available flavors of Windows, it has proven 
difficult to validate STAT for Windows. 
2 The STAT add-in contains the menus and functions discussed in this report with the exception of those items 
included in section 7. 
3 Add-In Manager is a library of functions which extend Excel's native capabilities. Specifically, this library 
coordinates the menu bar display so that menus appropriate for a specific add-in (such as STAT) appear when 
workbooks "belonging" to that add-in are active. 
4 File names follow the DOS 8.3 conventions in order to make them compatible with the largest possible number 
of Excel versions and operating systems. 



the Excel folder on your hard drive. Run Excel, choose the Add-ins command on the Tools menu, 
check the boxes next to "Add-In Manager" and "SHADWELL Test Analysis Tool" and click on 
"OK" to load and activate the add-ins. Under some conditions, it may be necessary to use the 
"Browse" button in the add-ins dialog to make Excel aware of the new add-ins. 

Once the add-ins have been correctly installed, an "Add-ins" menu will appear on the menu bar. 
This process only needs to be performed once; subsequently, the add-ins will automatically load 
whenever Excel is started unless they have been deselected by unchecking the boxes in the Add-ins 
dialog box. 

2.0 OVERVIEW 

2.1 Activating STAT 

When a new workbook is created by STAT, a special code is used to flag the workbook so that it 
"belongs" to STAT. Since normal workbooks (i.e., those not created from within STAT) lack this 
signature, it is possible to differentiate between them. This mechanism is used to provide a custom 
menu bar that, by default, automatically appears whenever a STAT workbook is active and 
disappears when a non-STAT workbook becomes active. 

However, this creates a chicken and egg problem - a STAT workbook can only be created with the 
custom "New Data Set..." command but that command does not appear until a STAT workbook is 
opened. To work around this problem, Add-In Manager appends an "Add-ins" menu to each Excel 
menu bar. Shown in Figure 1, this menu contains "About..." and "None" items, plus a list of all 
installed Add-In Manager-compatible add-ins. Add-In Manager functions are not restricted to 
STAT - they are available for use by any add-in to synchronize the available menu commands with 
the active workbook. 

File   Edit   Window 

Figure 1. The "Add-ins" menu switches between custom menu bars for 
various add-ins and the standard Excel menu bars. The "About..." 
item provides version and copyright information. 

By choosing "STAT" from the "Add-ins" menu, you can force the STAT menu bar to appear. 
Likewise, choosing "None" causes the appropriate standard Excel menu bar to reappear. The 
"About..." item provides version and copyright information for Add-In Manager or for the 
currently active add-in. 

2.2     Importing Data 

The STAT menu bar, shown in Figure 2, initially provides commands for creating new data sets 
and for opening existing ones. Selecting the "New Data Set..." item brings up a dialog box in 
which the user enters a description of the experiment. Only the ignition time and file path are 
critical; the remaining fields may be filled in with any information that is meaningful to the user. 
Clicking on the "Select Data File" button in the dialog box brings up the standard open file dialog 
and allows the user to set the path to the data file which is to be imported. 
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Figure 2. The STAT "File" menu permits creation and manipulation of data 
workbooks, including adding new channels to an existing data set. 

In order to activate the "Import" button, all fields (including the target data file path) must be filled 
in and the correct time and date formats (indicated below the "Date" and "Ignition" fields) must be 
used. Clicking on "Import" creates the new workbook. 

During the import process, a new column for elapsed time (in seconds) is inserted into the data 
immediately following the original MassComp clock time column (24-hour time in hh:mm:ss 
format). The ignition time entered by the user must be accurate because it is needed to make this 
conversion. 

After the base file has been imported, the "Append Channels..." command will be enabled, 
allowing additional channels from other files to be added to the data set. This is necessary because, 
as mentioned previously, each of the MassComp's two A/D systems generates a separate file 
containing up to 200 channels. STAT is capable of handling an arbitrary number of files (limited 
by the amount of memory available) but two data files are sufficient for the data sets produced by 
the current SHADWELL data collection system. 

The "New Data Set..." dialog box is used for selecting additional files, except that only the "Select 
Data File" button is active. The process of inserting new data into the workbook can be very time 
consuming if the appended file is large. 

Because the same channel numbers may be used in different files, STAT automatically appends a 
file sequence number to each channel number. Thus, n.l represents channel n in the first file, n.2 
indicates the same channel in the second file and n.m is channel n from file m. 

2.3     Defining Test Configuration 

After one or more data files have been imported, the "Configuration" menu (Figure 3) becomes 
active, providing a method for the user to set up a configuration for each channel which is of 
interest. This must be done before any data analysis may be carried out because the data analysis 
functions use this information to determine which columns to process. Accordingly, the "Data" 
menu remains disabled until the channel configuration has been performed. 
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Figure 3. Lists of compartments, sensor types and physical units are edited 
through the first three menu items. After this is done, each channel 
may be configured using the "Channel Configuration..." item. 
Alternatively, pre-existing configurations may be imported for 
reuse. 

The first step in creating a configuration is to use the "Compartment List...," Sensors List..." and 
"Units List..." commands to create lists of compartment names, types of sensors and physical 
units used by the sensors. Initially, these lists are empty; items may be added through a set of 
dialog boxes which display lists of the existing values, if any. The dialog boxes also permit 
deletion of entries. After editing has been completed, clicking on the "Done" button makes the 
changes permanent; "Cancel" discards the changes and reverts to the original list. Sample 
compartment, sensor and units lists are presented in Table 1. 

Cmpts Sensors Units 
Sail Air Thermocouple Deg.C 
Fan Room Bulkhead Thermocouple % 
Control Room Deck Thermocouple % Transmission 
Combat Systems Overhead Thermocouple PSI 
Escape Trunk Oxygen Volts 
Crew Messroom Carbon Dioxide kW/mA2 
Wardroom Carbon Monoxide 
Crew Living Calorimeter 
CPO Living Radiometer 
AMR Optical Density 
Laundry Pressure 
Torpedo Room Logic 
Storeroom Flame Thermocouple 
AMR Bilge 
Battery Compartment 
Bilge 
Laundry Passageway 

Table 1. Typical compartment, sensor and units lists created as part of the 
configuration process. 

After the above three lists have been created, the data channels of interest in your analysis must be 
described via the "Channel Configuration..." menu item. This command presents another dialog 
box that allows the compartment, sensor type and physical units of each sensor to be defined. To 
reduce the chance of making errors during data entry, these fields are completed by selecting the 
compartment name, instrument type and physical units from popup menus based on the lists 
created in the previous step. 



Optionally, additional information regarding the exact location of the instrument within the 
compartment may also be entered. At present, this information is not used by STAT but it is 
envisioned that, in a future version, it will be possible to select sensors on the basis of their 
coordinates with the compartment. Note that STAT does not define a coordinate system so the user 
is free to use any convenient convention. 

Status information, including the channel identifiers (channel number plus file sequence number), 
the index of the current channel (channel indices run from one to the number of channels and are 
independent of the identifiers assigned to each channel), total number of channels and current 
channel status are also displayed in the dialog box but can not be edited. 

Altering any configuration entry will activate the "Change" button. If you move to a different 
channel (using any of the navigation buttons), modifications to the original channel will be 
discarded. No changes become permanent until you click on "Done." Clicking on "Cancel" at any 
time will revert to the configuration which existed before the dialog box opened. 

The process of creating a complete channel configuration is somewhat time consuming but, once 
entered, the entire configuration may be exported (as an ASCII file) for reuse by another STAT file 
or for use in other programs. The "Channel Configuration..." dialog box also permits editing of 
previous files when the configurations of only a few channels have changed. 

As an example, Table 2 shows part of a typical channel configuration file. The complete 
configuration has one record for each channel used in the test, but configurations for channels 
which are not of interest for the analysis may be left undefined. 

Chan Sensor Units Cmpt X(m) Y(m) Z(m) 

142.1 Deck Thermocouple Deg.C Control Room 0 0 0 
143.1 Bulkhead Thermocouple Deg.C Torpedo Room 0 0 1.5 
144.1 Bulkhead Thermocouple Deg.C Laundry 0 0 1.5 
165.1 Oxygen % Laundry 0 0 0 
166.1 Oxygen % Control Room 0 0 0 
167.1 Oxygen % Control Room 0 0 0 
168.1 Oxygen % Laundry 0 0 0 
169.1 Carbon Dioxide % Control Room 0 0 0 
170.1 Carbon Dioxide % Control Room 0 0 0 
171.1 Carbon Dioxide % Laundry 0 0 0 
172.1 Carbon Dioxide % Laundry 0 0 0 
173.1 Carbon Monoxide % Control Room 0 0 0 
174.1 Carbon Monoxide % Control Room 0 0 0 
175.1 Carbon Monoxide % Laundry 0 0 0 
176.1 Carbon Monoxide % Laundry 0 0 0 
189.1 Logic Volts Laundry 0 0 0 

Table 2. Part of a typical channel configuration file. Configurations for 
channels which are not required by the analysis need not be defined. 
X, Y and Z refer to a user-defined coordinate system. In this 
example, X and Y were not used and Z is the elevation above the 
compartment deck. 

2.4     Processing Data 

After the raw data have been imported and the channel configuration has been defined, the "Data" 
menu (Figure 4) becomes active. "Data" menu commands only operate on the currently active page 
of the workbook except for the "Select..." command, which can operate on all of the raw data 



pages simultaneously. To protect the integrity of the original data, selected data are copied to 
another page in the workbook and all data-altering functions are disabled if the active page is one of 
the raw data pages. 
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Figure 4. The "Data" menu provides tools for selecting data, filtering outliers, 
normalizing or smoothing channels and calculating sample means 
and standard deviations for multiple sensors. 

Using the "Select..." command, the user may choose specific channels, based on the compartment 
and type of instrument, for further analysis. The selection dialog box provides checkboxes to 
enable selection by compartment or by sensor type or both. When either box is checked, the 
appropriate pop-up menu becomes active, allowing a specific compartment or sensor type to be 
chosen. If a box is left unchecked, then all compartments or all sensor types will be included in the 
selection. 

By default, the selected data is copied to a new page with a user-assigned name. Alternatively, any 
existing page (except for one of the raw data pages) may be chosen as the destination. In the latter 
case, whatever data already exists on that page will be overwritten. The user is warned before this 
happens. 

Once data have been selected and copied to a new page, additional data processing options become 
available. Generally, the first step will be to filter the data to identify outliers. The "Filter..." 
command displays a dialog box which allows the user to specify a subset of the data on the current 
page (by choosing from pop-up menus similar to those used for the original data selection), 
minimum and maximum allowable values, a window width and a threshold deviation (expressed in 
standard deviations). All points which fail any of the filter tests are flagged but are not altered or 
removed from the data set. 

Clicking on the "Filter" button causes STAT to scan the specified channels and to flag values 
which are less than the minimum or greater than the maximum. A sliding window average is then 
performed on the points which passed this first test. Points that exceed the specified deviation from 
the window average are flagged by this second test. The minimum, maximum, window width, 
threshold and number of flagged values is reported at the bottom of each column of processed data. 

Flagged points are displayed in red for easy identification and the normalization, smoothing and 
statistical analysis functions (described below) each provide an "Honor filter" option (checked by 
default) which excludes data that were flagged by the filter. If the original filter conditions are 
deemed to have been too stringent or too lenient, the "Clear Filter..." command can be used to 
remove the flags and set the text back to black. The filter operation may then be repeated with 
different parameters. 



The "Normalize Data" dialog provides radio buttons and pop-up menus, identical to those in "Filter 
Data," to select a subset of the data on the active page. It also permits a choice of two operating 
modes, a mean value mode which corrects for systematic differences among nominally identical 
sensors and an absolute value mode which adjusts the sensor outputs to a known value. The 
former is useful when there are multiple sensors (thermocouples, for example) giving different 
readings and the actual value of the parameter (room temperature, in this case) is not known. If the 
correct value is known (as it often is for oxygen or carbon dioxide concentration), then the absolute 
value mode may be used. 

In either case, all of the pre-ignition data from a sensor are averaged, on the assumption that 
conditions in a compartment tend to be relatively constant during the period prior to ignition. If the 
mean value mode is used, then the weighted average of all the specified sensors is used as the 
target value. In the absolute value mode, the target value is that specified by the user. For each 
sensor, the offset between the sensor mean and the target value is calculated and that offset is then 
subtracted from all data from that sensor for the duration of the test. The calculated pre-ignition 
mean, the target value and the offset value is reported at the bottom of each column of data. The 
state of the "Honor filter" flag is also reported, with "TRUE" indicating that filtered values were 
excluded from the calculation and "FALSE" meaning that they were not excluded. 

This has the effect of adjusting all the specified channels so that they have the same average over 
the period from the start of data acquisition to ignition and they report the deviation from that 
average for all post-ignition times. The absolute value mode can be used even if there is only a 
single data channel while the mean value mode requires at least two channels so that an ensemble 
mean may be calculated. 

Using the "Smooth..." command, it is possible to smooth data using a sliding window. As usual, 
the dialog allows a data subset to be chosen and the window width to be set. "Smooth..." is very 
similar to the "Filter..." command, except that the smoothing routine replaces each value by the 
mean of all values within the window. This is done in two passes, calculation and replacement, to 
ensure that all means are based only on the original values and not on a mixture of replaced and 
original values. 

The window width and the state of the "Honor filter" flag is reported at the bottom of each column. 
As before, "TRUE" means that filtered values were excluded; "FALSE" indicates that they were 
not. 

Finally, if there are duplicate sensors within a compartment, the "Statistics..." command can 
combine the data to yield compartment means and standard deviations as a function of time. A 
subset of the data on the page may be selected (based on sensor type and the compartment) and 
these channels are averaged for each time step. The number of values used in the calculation, the 
mean value and the standard deviation are reported in three columns which are added at the end of 
the data. As usual, filtered data may be excluded or included in the calculations by selecting or 
deselecting the "Honor filter" checkbox in the "Statistics..." dialog. 

2.5     Data Output 

The "Export Data..." command in the "File" menu exports the entire active page in the form of an 
ASCII file which can be opened and used in another application. Note that data values which were 
flagged for exceeding the filter criteria are not exported. 

For many purposes, such as graphing of the means and standard deviations calculated by 
"Statistics...," it may be easier to simply copy the required columns and paste them into another 
application. 



PART II       MENU COMMANDS 

Part II discusses the details of all STAT menu commands and their corresponding dialog boxes. 
Each menu is the subject of a separate section presented in the order (left to right) in which the 
menus appear on the menu bar. 

3.0     FILE MENU 

The "File" menu, shown in Figure 5, provides standard file manipulation commands, plus 
customized commands for creating a STAT workbook ("New Data Set..."), adding channels to an 
existing STAT workbook ("Append Channels...") and exporting processed data ("Export 
Data..."). 
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Save 
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Figure 5.        The STAT "File" menu. 

3.1     New Data Set 

The "New Data Set..." command displays the dialog box shown in Figure 6. The test tide, date, 
series and number fields can contain any meaningful descriptive information. The ignition time 
must be correct because that value is used to calculate the elapsed time (zero is set to the ignition 
time). After a file has been selected for import, the complete file path will appear in the space to the 
right of the "Select Data File" button. 

The "Import" button will not be activated until all text edit boxes have been filled in, the "Date" and 
"Ignition" entries have been correctly formatted (the proper format is indicated below the fields) 
and a data file has been selected. At that point, clicking on the "Import" button will create a new 
workbook, import the ASCII data from the specified file and name the data page "Raw Data 1." 
This name must not be changed because the data processing routines expect to find a page with that 
name. Clicking on the "Cancel" button at any time will close the dialog without creating a 
workbook or importing any data. 

The selected data file must be in the format produced by the MassComp TRANSLATE program: 

a.        ASCII text; 



b. fixed width columns; 
c. experiment time, in hh:mm:ss format, in the first column; 
d. each channel in a separate column, starting with the second column; 
e. channel numbers in the first row of each column (except the time column); 
f. units, or other descriptive information, in the second row of each column (except 

the time column); and 
g. the first data (including time) in the third row of each column. 

; Experiment Description 

T«3t Program Title: 

Date: Sen"«: JO Number: 10 I Ignition: 

(mm/dd/uy) (hh:mm^3)i 

Select Data File 
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Figure 6.        Information describing the experiment must be entered in this dialog 
box before a new data set can be created. 

The file created by "New Data Set..." contains hidden information which identifies it as a STAT 
workbook. Add-In Manager uses this information to switch to the STAT custom menu bar. Files 
created with the normal Excel "New..." command lack this information and will not cause 
automatic menu bar switching. 

3.2     Append Channels 

As seen in Figure 7, "Append Channels..." reuses the "New Data Set..." dialog box, but this time 
the only field that can be changed is the data file path - all other fields retain their original values 
and are not editable. When a file has been selected, the "Import" button again becomes active and 
clicking on it imports the contents of the specified file and places the data on a new page in the 
active workbook. Clicking on "Cancel" closes the dialog box without making any changes to the 
workbook. 

Due to the way that Excel opens files, the data are not imported directly into the active workbook. 
Instead, a temporary workbook containing the to-be-appended data is created, the data are copied 
and pasted column by column into the current workbook and the temporary workbook is closed 
and deleted. For large files, this may be very slow due to the number of copy and paste operations 
required. The data from each appended file appear on a new page, named "Raw Data 2," "Raw 
Data 3," and so forth. Again, these names must not be changed. 
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Figure 7. All of the original information, except the file path, reappears just as 
it was entered in the "New Data Set..." dialog but can not be edited. 
A new data file must be selected. 

3.3 Open 

The "Open..." command displays a standard open file dialog box and allows any Excel workbook 
file to be opened. Non-workbook files (such as ASCII files and comma-delimited files) will not 
appear in the open file dialog. If the opened file is not a STAT workbook {i.e., was not created 
with STAT's custom "New Data Set..." command), the menu bar will revert to Excel's default 
menu bar after the file is opened. 

3.4 Close 

"Close" closes the active workbook. If any changes have not yet been saved, Excel will ask 
whether to save changes; the options will be "Yes" (save changes and close file), "No" (close file 
without saving changes), "Cancel" (do not close file and do not save changes) and "Help" (open 
Microsoft on-line manual). 

STAT maintains hidden information stored in the workbooks so it is possible that Excel will ask 
about saving changes even when you have not explicitly made any changes. Under these 
circumstances, it is best to click on the "Yes" button. 

3.5 Save 

"Save" saves the active workbook to disk. 

WARNING! 
The default name for a new STAT workbook is the name of the 
original ASCII data file. If the "Save As..." command has not been 
used to change this name, the "Save" command will overwrite the 
original ASCII file without warning. 

11 



3.6 Save As 

The "Save As..." command will open a save file dialog box which will permit the file to be saved 
with a new name in a new location. This dialog will not permit the file type to be changed from a 
normal Excel workbook to any other type (tab- or comma-delimited text, for example). 

After a new STAT workbook has been created, this command should be used to change the default 
name to prevent accidental overwriting of the original ASCII data file. 

3.7 Export Data 

"Export Data..." saves the contents of the active worksheet (not the entire workbook) to an ASCII 
file with a name and location of your choice. This file may then be opened and used in other 
applications. Note that values which were flagged for exceeding the filter criteria are stripped from 
the exported data but are not removed from the worksheet. This function does not operate on pages 
containing raw data (for example, "Raw Data 1") because that would only reproduce the original 
ASCII input file. 

3.8 Page Setup 

"Page Setup..." provides the standard Excel dialog box for setting page orientation, margins, page 
header and footers and similar options. 

3.9 Print Preview 

The "Print Preview" command displays the active worksheet, formatted as it would appear when 
printed according to the current page setup options. 

3.10 Print 

"Print..." brings up the normal print dialog box which allows print options (number of copies, 
page range, etc.) to be specified before the file is sent to the selected printer. 

3.11 Quit 

"Quit" terminates the session, allowing all open workbooks to be closed (with options to save 
changes, if necessary), and shuts down Excel. 

4.0     EDIT MENU 

Figure 8 shows the "Edit" menu, which provides the standard commands for editing the contents 
of cells, plus a command to delete the currently active worksheet. However, to protect the integrity 
of the data, some menu items are not enabled or are enabled only under certain conditions. 

File Data   Configuration   Add-lns   Help 

Times 

A2 
Copy 
Paste 

Delete Sl^eet 

\WV>'iVmY*Wi 
Bj /I Hi • i;;;;"':3 

»mWiW:::to>WWV»WW>>: 
' :-j| :**i;;ri 

Figure 8. The STAT "Edit" menu. 
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4.1 Cut 

In order to maintain data integrity, STAT does not permit data to be cut from, or pasted to, 
individual cells. Accordingly, the "Cut" command is always disabled. 

4.2 Copy 

"Copy" allows the contents of selected data cells to be copied to the clipboard for transfer to other 
programs or non-STAT workbooks. Data can not be transferred to another STAT worksheet 
because STAT workbooks do not permit pasting. 

4.3 Paste 

In order to maintain data integrity, STAT does not permit data to be cut from, or pasted to, 
individual cells. Accordingly, the "Paste" command is always disabled. 

4.4 Delete Sheet 

The "Delete Sheet" command deletes the currently active worksheet from the workbook. Excel 
asks for confirmation before completing this operation. To protect the original data, "Delete Sheet" 
is always disabled when the active worksheet is one of the raw data pages. 

5.0     DATA MENU 

The "Data" menu (Figure 9) provides commands for selecting subsets of the data, filtering to detect 
outliers, normalizing channels, smoothing data and calculating basic sample statistics. 

File   Edit 

Times 

Al a 

Configuration   Add-lns   Help 
j elect««« 

Filter.« 
Clear Filter... 

Normalize Sensor. 
Smooth». 

Statistics. 

m •Btltl** i'l I i I i j"<':: 

.y.%-.ws%<l.-.%,W<xv.j 

Figure 9.        The STAT "Data" menu. 

5.1     Select 

The "Select..." command allows a subset of the data on the currently active worksheet to be 
chosen. It displays a dialog box, shown in Figure 10, which allows the choice of one or both of 
the two selection criteria: "By compartment" and "By sensor type" (you must choose at least one of 
these or the "Select" button will not become active). If either checkbox is left unchecked, then all 
compartments (or sensor types, as appropriate) are accepted. When a box is checked, the 
corresponding pop-up menu becomes active, as seen in Figure 11, so that a single compartment or 
sensor type may be chosen. The two criteria are ANDed together {i.e., the channel is not selected 
unless the sensor configuration matches both the specified compartment and the specified sensor 
type). 
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Figure 10. This "Select Data" dialog box allows data to be selected by 
compartment or by sensor type, or both. The selected columns are 
moved to a new sheet by default, but may be sent to an existing 
sheet by choosing the "Existing sheet" option. 

All columns matching the selection criteria are copied to another page in the workbook. By default, 
they will be moved to a new page (you must enter a name for this page in the "New sheet" text edit 
box). However, if you click on the "Existing sheet" radio button, the page pop-up becomes 
enabled and you can select a pre-existing worksheet. This option will replace all of the data on the 
target page with the new selection but there is a confirmation dialog to make sure that is what you 
really intended. None of the raw data pages are included in the list of eligible target pages, so none 
of them can be overwritten. 

If there are no channels on the active worksheet which match the specified selection criteria, then a 
dialog will appear stating that no matches could be found. 

5.2     Filter 

"Filter..." allows you to exclude bad data points from subsequent calculations on the basis of either 
absolute or relative values. Points which exceed the thresholds are flagged and displayed in red but 
are not removed or altered. This allows the user to see the effects of different filter criteria and 
easily revert to the original data if the results are not as desired (see section 5.3 for more details). 
This function operates on all, or a specified subset, of the data on the active worksheet. 

The absolute value options permit filtering of values which are greater than a specified maximum or 
less than a given minimum. This is intended to be used for cases in which the user knows a priori 
that certain ranges of values represent bad data. For example, values corresponding to open circuit 
or short circuit transducers can be removed from further consideration. 
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Figure 11. If one of the selection criteria boxes is checked, the corresponding 
pop-up menu is enabled and a specific compartment or sensor type 
may be chosen. The "Existing sheet" pop-up is similar. 

The relative value option performs a sliding window average and determines whether the central 
point in the window is greater than a specified number of standard deviations from the window 
average. For a set of values {xi - XN} and a window width w, the sliding window mean is given 
by 

—      lm- 
X- = —X*i where 

1    nm, 
Eqn. 1 

m, 

m u 

={ 

={ 

l(forj-w'<l) 
j-w' (for j-w'>l) ' 

j+w' (for j+w'<N) 
N(forj+w'>N)     ; 

Eqn. 2 

Eqn. 3 

,     (w-1) 
W = and Eqn. 4 

n is the number of Xj values in equation 1 which are numeric and which lie within the range 
defined by the user-specified minima and maxima. 

15 



The standard deviation for the window is calculated as 

1       m 

sd = 
(n-l)m, 

SCxj-x.)' Eqn. 5 

This function is useful, for example, in cases where there are significant spikes which may or may 
not represent valid data. Both the width of the window over which averaging is performed and the 
threshold deviation from this average can be set by the user. 

Filter Data 
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Figure 12. A subset of the data on the active page may be chosen by selecting 
from the pop-up menus. The window width and standard deviation 
threshold are selected by clicking on the corresponding up- or 
down-arrow buttons in the "Exclude Outliers" section. 

16 



The dialog box shown in Figure 12 is used to set the desired filter parameters. If the active page 
contains data from more than one compartment, then the user may choose to filter data from all of 
these compartments or from one selected compartment. In the event that there are data from only 
one compartment, then the "All" option is disabled. The sensor type may be specified in a similar 
manner. 

If either "Exclude values less than" or "Exclude values greater than" is checked, then the 
corresponding text box becomes active. An appropriate numerical value must be entered or the 
"Filter" button will be disabled. When "Exclude outliers" is checked, the standard deviation and 
window width up- and down-arrow buttons are active. The standard deviation threshold can be set 
between one and five standard deviations, in steps of 0.1. Similarly, the width of the sliding 
window is adjustable, in two-point increments, from five to 99 points. Only odd widths are 
permitted to ensure that there is always a middle point. 

Remember that, by using the compartment and sensor selection buttons, it is possible to apply 
different filter criteria to different columns of data on the same page. Therefore, for convenience, 
the filter parameters (minimum, maximum, window width and standard deviation threshold) and 
the number of flagged values are written at the end of each column. 

Note that there is a subtle distinction between absolute and relative value filtering. In the former, 
data which exceed the user specified limits are assumed to be invalid. Therefore, they are 
immediately excluded and are never used in any filter calculations. In particular, they never affect 
the sliding window average. For the relative value case, all data are assumed to be valid unless they 
fail the statistical test. This means that they are included in the calculation of the window average 
and therefore can affect the decision as to whether other points should, or should not, be excluded. 

An example of data filtering is shown in columns two and three of Table 3. For this case, no 
minimum or maximum limits were specified, a five-point window was used and values exceeding 
1.5 standard deviations from the window mean were flagged (note values shown in red). A total of 
130 values from channel 135.1 were flagged; 162 from channel 136.1. 

WARNING! 
"Filter..." is a computationally intensive operation which can be 
very time consuming. Even on fast PowerPC and Pentium 
computers, the process may require several minutes per data 
column. 

5.3 Clear Filter 

"Clear Filter..." is enabled if any data on the current page has been filtered. The dialog box (Figure 
13) has controls identical to those in the "Filter..." dialog box for choosing a subset of the data. 
Clicking on the "Clear" button causes the results of previous filter operations to be undone, 
resetting the specified data to the unfiltered state. The filter parameter information at the bottom of 
the columns is also cleared by this function. "Clear Filter..." is useful if the filter parameters were 
determined to have been either too stringent or too lenient and you wish to start over. 

5.4 Normalize Sensor 

"Normalize Sensor..." corrects for errors in the zero offset of sensors. As seen in Figure 14, a 
subset of the data on the active page may be selected using the same controls that were provided for 
the "Filter..." command. The radio buttons permit the user to select either mean value mode or 
absolute value mode. The former adjusts the offset of each of the selected channels so that the pre- 
ignition mean value for that sensor is equal to the pre-ignition mean of all sensors of the same type 
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Filtered Data Filtered & Normalized Statistical Calculations 
Data 

Elapsed Chan. 135.1 Chan. 136.1 Chan. 135.1 Chan. 136.1 Laundry + Flame Thermocouple 
Time 
Sec Temp (°C)    Temp (°C) Temp (°C) Temp (°C) N          Mean Std. Dev. 

-10 27.61 6.95 26.3219379 8.3159687 1  8.31596851 
-9 9.54 4.62 8.2519379 5.9859687 2 7.11895323 1.60228217 
-8 16.73 9.4 15.4419379 10.7659687 2  13.1039534 3.3064096 
-7 6.9 7.96 5.6119379 9.3259687 2 7.46895313 2.62621641 
-6 13.35 12.27 12.0619379 13.6359687 1   12.0619383 
-5 27.89 6.17 26.6019379 7.5359687 2  17.0689526 13.4816761 
-4 1.11 7.56 -0.1780621 8.9259687 2 4.37395334 6.43752193 
-3 23.71 12.62 22.4219379 13.9859687 2  18.2039528 5.96513128 
-2 6.55 12.2 5.2619379 13.5659687 2 9.41395378 5.87183619 
-1 15.85 12.49 14.5619379 13.8559687 2  14.2089539 0.49919561 
0 8.33 11.07 7.0419379 12.4359687 2 9.73895359 3.81415582 
1 7.37 13.01 6.0819379 14.3759687 2  10.2289534 5.86476564 
2 26.25 7.71 24.9619379 9.0759687 2  17.0189533 11.2330761 
3 0.71 9.62 -0.5780621 10.9859687 2 5.20395327 8.17700481 
4 16.73 21.41 15.4419379 22.7759687 1   15.4419374 
5 7.29 13.55 6.0019379 14.9159687 2   10.4589529 6.30317163 
6 19.05 13.88 17.7619379 15.2459687 2   16.5039539 1.77905893 
7 17.07 24.47 15.7819379 25.8359687 2 20.8089523 7.10927343 
8 8.98 16.9 7.6919379 18.2659687 2   12.9789534 7.47696877 
9 15.06 20.66 13.7719379 22.0259687 2   17.8989544 5.83648109 

10 5.62 23.12 4.3319379 24.4859687 2  14.4089537 14.2510519 

Filter: 
Min = 
Max = 
Window = 5 5 
Threshold = 1.5 1.5 
Count = 130 162 

Normalize: 
Filtered = TRUE TRUE 
Mean = 12.1314898 9.47745895 
Target = 10.8434277 10.8434277 
Delta = 1.2880621 -1.3659687 s 

Table 3. An excerpt from a worksheet showing the effects of filtering 
(columns two and three), normalization (columns four and five) and 
statistical calculation (columns six through eight). 

in the same compartment. In the latter mode, offsets are adjusted so that the pre-ignition mean of 
each sensor is equal to a user specified value. If "Honor filter" has been checked, then values 
flagged by the "Filter..." command are not included in calculating the pre-ignitions mean values. 
For reference, the state of "Honor filter," the pre-ignition mean value, the target value (either the 
ensemble mean or a user-specified absolute value) and the calculated offset are shown at the bottom 
of each column. 

Columns four and five in Table 3 illustrate the effects of normalization using the mean value mode. 
For each column, the values shown in blue were averaged to obtain the pre-ignition mean for that 
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Figure 13.      Flags set by previously filter operations may be cleared with this 
dialog. 

sensor (Mean) and these per-sensor means were then combined to get an ensemble mean (Target). 
The offset between the sensor mean and the ensemble mean was calculated (Delta = Mean - Target) 
for each column and subtracted from each value in the column. Since "Honor filter" was TRUE, 
the values flagged in red were not included in the calculations of the means. 

Mean value mode is typically used if there are several sensors of the same type in the same 
compartment and the correct value of the measured parameter is not known a priori. Note that this 
mode requires that there be at least two sensors in the selected data subset. The absolute value 
option is appropriate if the correct value is known. The latter method can be used even if only one 
sensor has been selected. 

For example, there may be a large number of thermocouples, each giving a different reading, in the 
same compartment. "Normalize Sensors..." allows you to adjust all of those thermocouples so that 
they give the same average reading for the period prior to ignition. In this case, it may be 
reasonable to assume that, prior to ignition, the compartment is approximately isothermal but the 
actual compartment temperature is not known. Using the mean value option, all of the 
thermocouples will be adjusted so that their individual pre-ignition means are equal to the 
compartment's ensemble average temperature for the pre-ignition period. 

Typically, it may be assumed that the compartment's pre-ignition atmospheric composition is also 
homogeneous. However, in this case, it may also be reasonable to assume that the species 
concentrations are those of normal air. If so, then it would be appropriate to select the absolute 
value method and to specify standard values for oxygen, carbon dioxide and carbon monoxide. 
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Figure 14. A subset of the data on the active page may be chosen by selecting 
from the pop-up menus. Channels may be normalized to the pre- 
ignition mean of all similar sensors in each compartment or to a 
user-specified value. If "Honor filter" is checked, then values 
flagged by the "Filter..." command are not included in the average. 

5.5     Smooth 

"Smooth..." performs a sliding window average, as was done by the "Filter..." command. 
However, "Smooth..." replaces the value of the middle point in the window with the window 
average. The dialog box (shown in Figure 15) has data selection controls identical to those used by 
previous commands. If "Honor filter" has been checked, then values flagged by the "Filter..." 
command are not included in calculating the window mean values. 

To ensure that raw data and mean values are not mixed when performing these calculation, this 
function processes the data in two passes. In the first pass, mean values are calculated from the 
raw data and stored in a temporary array. During the second pass, the smoothed data are copied 
back to the worksheet. 

The width of the sliding window and the state of the "Honor filter" flag are both appended at the 
end of each column. If "Filtered" is TRUE, then all values for which the flag had been set were 
ignored in the calculation of the window mean. 
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Figure 15. A sliding window average may be calculated for a subset of the data 
on the active page, as selected from the pop-up menus. The window 
width is chosen by clicking on the up- or down-arrow buttons in the 
"Smoothing Parameters" section. If "Honor filter" is checked, then 
values flagged by the "Filter..." command are not included in the 
window average. 

5.6     Statistics 

"Statistics..." calculates the sample means and standard deviations for all sensors (of the same type 
and located in the same compartment) specified in the dialog box shown in Figure 16. 

Unlike the "Normalize..." and "Smooth..." commands, "Statistics..." processes data from multiple 
channels on a sample by sample basis to produce a time series of ensemble means. Results are 
presented in three columns, appended to the end of the existing data, which give the number of 
samples used in the calculation (N), the mean of the N values and the standard deviation from that 
mean. As usual, if "Honor filter" is checked, then all values which were flagged by the "Filter..." 
command are ignored. 
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6.0     CONFIGURATION MENU 

The "Configuration" menu, shown in Figure 17, provides commands for setting up lists of 
compartments, sensor types and physical units and for configuring the data channels. 
Configurations may be exported as ASCII files and may be imported for reuse in another STAT 
workbook. 
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Figure 16. The mean and standard deviation of the selected data subset is 
calculated. If "Honor filter" is checked, then values flagged by the 
"Filter..." command are not included in the calculations. 

6.1     Compartment List 

The "Compartment List..." command opens a dialog box which permits the current list of 
compartments to be edited. Initially, only an empty text edit field is presented. Typing a 
compartment name in this field (see Figure 18) activates the "Add" button; clicking on this button 
puts the new name into the working copy of the compartment list. It is possible to delete entries by 
selecting one from the pop-up list (Figure 19) and clicking on the "Delete" button. After all editing 
is completed, clicking the "Done" button makes the changes permanent. Clicking on "Cancel" at 
any time closes the dialog and discards all changes. 

The "Channel Configuration..." dialog uses this compartment list as a pop-up menu in order to 
ensure that names are spelled consistently for all channel configurations.. The compartment list is 
also used by the data processing commands (discussed above), so that the data selectors do not 
overlook sensors due to simple typographical errors. 

22 



Hie    Edit   Data 
■ in 11111 IT 11 ' 

Times UP 

A1 

mil Add-Ins    Help 
Compartment List. 
Sensors List... 
Units List... 

v5:5 ::':*:W.fff 

| Channel Configuration 
Import Configuration... 
Export Configuration 

WWUUiiUtUHU 

Figure 17.       The STAT "Configuration" menu. 
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Figure 18. After typing in a new name, the "Add" button becomes active so that 
new compartments may be entered. 

6.2 Sensors List 

"Sensors List..." (Figure 20) behaves in exactly the same fashion as the "Compartment List..." 
command and allows editing of the list of sensor types. As before, this list is used in pop-up 
menus to reduce the chances of data entry errors. 

6.3 Units List 

"Units List..." (Figure 21) also uses a dialog box like that used by the "Compartment List..." and 
"Sensors List..." commands. The units in question are those in which the various sensors report 
their results and, as before, this list is used in pop-up menus to reduce the chances of data entry 
errors. 

Note that there is a single, global list of physical units rather than a separate list for each type of 
sensor. You might want to include both metric and English units in the list and choose the 
appropriate ones when the channels are configured (see the Channel Configuration section, 
below). 

6.4 Channel Configuration 

The "Channel Configuration..." command provides the mechanism by which information 
regarding a sensor may be associated with a specific data channel. Using the dialog box shown in 
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Figure 19. Compartments can be deleted by selecting from the pop-up menu 
and clicking on the "Delete" button. 
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Figure 20.       Sensor types can be created and deleted just as compartments were. 

Figure 22, the user can choose any channel in the current data set and select the compartment, 
sensor type and physical units from pop-up lists (which are based on the inputs created by the three 
list-editing commands discussed above). In addition, the location of the sensor may be defined in 
any convenient coordinate system. STAT pre-defines metric and English dimensional units (meters 
and feet, respectively). In the current version, this list can not be edited. 

The "Current Index" field indicates the location of the current data record within the channel 
database, the "Current Status" field indicates that no information has been entered ("Invalid"), no 
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Figure 21.      The list of physical units used by the sensors can be created and 
deleted using this dialog. 
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Figure 22. The compartment, sensor type, physical units and sensor location 
within the compartment are associated with a specific channel 
through this dialog box. 

change has been made ("Unchanged"), the working database has not been updated ("Pending") or 
the working database has been updated ("Changed"). 

The index is a sequence number in the range one through the total number of channels (326, in the 
example shown) and is independent of the channel identifier, which is also shown in the dialog. 
The latter is determined from the raw data file(s) and can not be altered. Therefore, the "Channel 
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Configuration..." editing capabilities can only be used to change the sensor description for a pre- 
existing channel, not to change the channel numbers themselves. 

The "Back" and "Next" buttons step through the channel database one channel at a time while the 
"First" and "Last" buttons take you to the first or last records, respectively. It is also possible to 
enter a channel ID number (in the form nnn.n) into the "Go to channel ID" text box. When a valid 
entry has been made, the "Go" button becomes active and permits a jump directly to the selected 
channel. 

If any field is changed (for example, a different compartment is selected or a new position is 
entered), the status changes to "Pending" and the "Change" button becomes active5. Clicking on 
"Change" updates the working copy of the database and activates the "Done" button; moving to 
another record without clicking on "Change" reverts the record to its original state. After all desired 
changes have been made, clicking on "Done" closes the dialog box and makes all modifications 
permanent. Clicking on "Cancel" at any time closes the dialog box and discards the changes. 

6.5 Import Configuration 

"Import Configuration..." uses the standard open file dialog to permit a complete configuration to 
be read from a previously saved configuration file. This is useful, for example, if the same 
channels were used for a series of experiments. 

Once a configuration has been imported, it can be edited as described above. Note, however, that 
channels can not be added or deleted - only the description of the instrument assigned to that 
channel can be altered. 

WARNING! 
Channel identifiers are determined by the raw data file(s) and can not 
be altered. Therefore, the "Channel Configuration..." editing 
capabilities can only be used to change the description of an 
instrument for a pre-existing channel, not to change the channel 
numbers themselves. Importing a configuration file with a different 
channel list will destroy the channel list associated with the current 
data. 

6.6 Export Configuration 

"Export Configuration..." uses the standard save file dialog to permit the current configuration to 
be saved as an ASCII configuration file for later reuse. This is useful, for example, if the same 
channels were used for a series of experiments. 

7.0     ADD-INS  MENU 

Unlike the previously discussed menus, "Add-Ins" is created and managed by Add-In Manager, 
rather than by any particular add-in. Its primary purpose is to permit an add-in to be activated even 
when no workbooks "belonging" to that add-in are open. Add-In Manager is required by STAT 
but is not a part of STAT. 

The "Add-Ins" menu (Figure 23) displays information about the current add-in (or about Add-In 
Manager) and provides a means of switching among various add-in menu bars or between an add- 
in menu bar and the standard Excel menu bar. 

5 Note that, when creating a new configuration, "Change" will be inactive until a selection has been made from each 
of the popup lists. 
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Figure 23.       The STAT "Add-Ins" menu. 

7.1     About 

The "About..." menu item provides a standard method for add-in authors to display information 
regarding their add-in. For STAT, the version number and a copyright notice is displayed (Figure 
24); other add-ins may display different information. If no Add-In Manager compatible add-in is 
active (e.g., the native Excel menu bar is displayed), then version and copyright information about 
Add-In Manager is shown. 
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Figure 24.      The STAT version and copyright is displayed when "About..." is 
selected. 

7.2 None 

The "None" menu item switches back to one the Excel built-in menu bars. Which menu bar is 
displayed depends on what kind of worksheet, if any, is active at the time the switch is made. 

7.3 <Add-In Name> 

This "item" is actually a list of all currently loaded, Add-In Manager compatible add-ins. Selecting 
any item from the list causes the corresponding add-in to become active. Use this to activate STAT 
when there are no STAT workbooks open. If a STAT workbook is open, the STAT menu will 
automatically be displayed whenever that workbook is activated. 
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